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What is Ascend
Ascend is a computer software program designed for use with the Franklin Day 
Planner.    Although anyone can increase their personal productivity with Ascend, its 
real strength comes from using it in the manner taught by The Franklin International 
Institute, Inc.    All reports and printouts generated by Ascend are designed to be 
printed on pages from a Franklin Day Planner.

For more information about Franklin International Institute, Inc. Contact:

Franklin International Institute, Inc.
2640 Decker Lake Blvd.
Salt Lake City, UT    84119
801-975-1776
1-800-654-1775



Performance Considerations
In order for Ascend to work optimally you must have sufficient, properly-configured 
hardware.    Chapter 13 of the Windows User's Guide discusses optimizing the 
performance of Windows.    It is highly recommended you read this chapter.    
Some items that will affect the speed of Windows, and therefore Ascend, are:

* Amount of memory (RAM) on your computer.
* Management of RAM.
* Type of microprocessor and its speed (286, 386, 486....)
* Disk caching installed for your hard drive.
* Type, speed, and condition of your hard drive.
* Type of computer and its architecture.



Who Can You Call For Help
If, after referring to the on-line help and the User's Guide, you are unable to answer a 
question or resolve a problem, you may call Ascend's Technical Support Help line.    If 
your question concerns Windows, you should call Microsoft's Help line.

Microsoft's Technical Support: 206-454-2030
Ascend's Technical Support: 801-975-9999

So that both Microsoft's and Ascend's technicians will be able to answer your 
questions quickly, it is a good idea to review some information before you call.    The 
last page of your Windows 3.0 User's Guide is an outline of information you should
know regarding your hardware configuration.    Please review this outline before 
calling either of these lines.



Registering Ascend
It is important you register your copy of Ascend!    By registering your copy you will 
be entitled to Technical Support and information about future upgrades and releases. 
Also, once installed, Ascend will only work for 60 days without a special 
"Key Number."    You will receive a Key Number when you purchase Ascend.

To register your copy of Ascend, perform the following steps:

1. After starting Ascend, select Help from Ascend's menu by clicking on Help or 
pressing [ALT]+[H].

2. Select the Registration option from the drop-down menu by clicking on 
Registration or pressing [H].

3. Tab through the fields of the dialog box entering: Serial Number, registered 
User's Name, and Key Number. 

4. Fill out your registration card with the information EXACTLY as it appears on 
the registration dialog box.

5. Verify the above information by pressing the [TAB] key.    An asterisk should 
appear to the right of the Key Number field.

6. Select OK or [ENTER].
7. Mail in your registration card.
Once you register your copy of Ascend with a valid key number, your copy of Ascend 
will work indefinitely.



Changing Ascend's "Current" Window
You may have several windows and/or icons on your screen at a time, but only one of 
the windows can be the "current" or "active" window.    You may recognize the current
window in several ways: 

the color of the current window's title bar will be different from the inactive 
windows.
the control-menu box, maximize box, and minimize box of the inactive 
windows will not be displayed in the title bar.

the active window will never have another window "in front" of it.

To change the "current" window:

Mouse Users

To activate an inactive, displayed window, simply click your mouse anywhere on the 
window you wish to activate.    If the window is minimized, double click your mouse on
the window's icon and the window will be restored and activated.    If you choose in 
preferences to display the Icon Bar a single click on the window's icon will activate 
the window.

Keyboard Users

There are three ways to select the current window from the keyboard:

1. Press [ALT]+[W] to display a list of the windows available in Ascend.    Use the 
cursor keys to select the window you wish to make active then press [ENTER].

2. Press the [SHIFT]+[F1] key to make the Prioritized Daily Task List the active 
window, [SHIFT]+[F2] for the Appointment Schedule, etc. through [SHIFT]+
[F12].    The order of the windows represented by [SHIFT]+[F1] through 
[SHIFT]+[F12] is the same as that displayed in the Windows menu described 
in option #1 above or on the Icon Bar.

3. You may "thumb through" each window and icon by pressing [CTRL]+[F6].    
Pressing the [F6] function key while holding down the [CTRL] key will rotate 
through each window and icon, highlighting them one at a time.    When you 
are at the desired icon or window, simply release the [CTRL] key.    (If the 
window selected is still in icon form, you will need to restore it to a window by 
pressing [ALT]+[-] and then [R].)



Changing Dates
The date displayed in Ascend's Tool Bar, between the arrow buttons, is called the 
Page Date.    This date represents the filler page date in your Franklin Day Planner.

Changing the Page Date, is like turning pages in your Franklin Day Planner to a new 
day.    Ascend needs this capability to forward tasks to new days, plan tasks for future 
dates, review upcoming meeting notes, etc.

There are several ways to change the Page Date to another day:

1. You may use the Goto menu to go to yesterday, today, tomorrow, forward a 
day, backward a day, forward a week, or backward a week.

2. You may use the Goto menu and then the Date sub-menu to pop-up a 
calendar.    From this "goto" calendar you may select the date you want to go 
to. 

3. If Goto appears in the menu you may press [F4] and the Goto Calendar will 
appear.    You may then use this calendar to change the Page Date.

4. You may quickly have the Page Date "jump" to the System Date (Today's Date)
by double clicking in the area of the Tool Bar that displays the Page Date.

5. Mouse users can use the Tool Bar to quickly change Page Dates.
As you change the Page Date, the System Date, shown in the Status Bar at the 
bottom of Ascend's window, remains unchanged.    If the Page Date and the System 
Date are different, a positive or negative number appears after the page date to tell 
you how many days your Page Date differs from "today's date."



Ascend's Tool Bar
For even quicker access to specific page dates mouse users may use Ascend's Tool 
Bar.    Simply click on the icon described below that performs the desired action.    The
elements of the Tool Bar are described below.    They are described in the order they 
appear on the Tool Bar, from left to right.

Moves back one month from the current page date.
Moves back one week from the current page date.
Moves back one day from the current page date.

Page Date You will see the page date displayed in this area.    If the page date differs from
the system date, the difference in days will be displayed in parenthesis after the page date.   
You may return to the current system date from any page date by double clicking in the 
page date area of the Tool Bar.

Moves forward one day from the current page date.
Moves forward one week from the current page date.
Moves forward one month from the current page date.
Activates a calendar that allows you instant access to any page date, merely by 

clicking on the desired date.    The calendar even "remembers" where you last positioned it 
for future Ascend sessions.    To close the calendar simply click on this icon again.

Special Days This drop-down list box will display any birthdays, anniversaries, or 
other special days you've designated.



Ascend's Status Ribbon
The bar at the bottom of Ascend's window is called the Status Ribbon and contains 
four fields.    They are described below as they appear, from left to right.

Current System Date Displays the current date and time as set in your 
computer.    This date is also called the System Date, 
Current Date or Today's Date and is updated once a 
minute.    

Registered User Displays the registered user's name.

CAPS Displays "CAPS" if the CAPS lock is on.

NUM Displays "NUM" if the NUM lock is on.



Common Ascend Menus
Each Ascend module has it's own menu.    However, the following menu options are 
common to all Ascend modules.

Control Menu
File Menu
Edit Menu
Window Menu
Options Menu
Help Menu



Control Menu
When you select the Control Menu by pressing [ALT]+[SPACEBAR] or clicking, on the
hyphen in the upper, left corner of the Ascend window, a drop-down menu will appear
with the following options:

Restore Returns a maximized or minimized window to its regular size, 
position, and color.

Move Allows the cursor keys to move the active window within Ascend's 
work space.

Size Allows the cursor keys to move the active window's borders, thus 
sizing the window.

Minimize Reduces the active window to an icon.

Maximize Enlarges the active window to occupy Ascend's entire work space.

Close Closes the active window, minimizing it to an icon.    ([CTRL]+[F4].)

Switch to Brings up a list of active applications.    ([CTRL]+[ESC].)

Control Panel This allows you to run Windows' Control Panel directly from Ascend.    
See your Windows User's Guide for Details on the Control Panel.

File Manager This allows you to run Windows' File Manager directly from Ascend.    
See your Windows User's Guide for Details on the File Manager.

Print ManagerThis allows you to run Windows' Print Manager directly from Ascend.   
See your Windows User's Guide for Details on the Print Manager.

Calculator This allows you to run Windows' Calculator directly from Ascend.    
See your Windows User's Guide for Details on the Calculator.

System Editor This allows you to run Windows' System Editor directly from Ascend.   
See your Windows User's Guide for Details on the System Editor.

Windows Setup This allows you to run the Windows Setup routine from within 
Ascend.    See your Windows User's Guide for Details on the Windows 
Setup.



File Menu
When you select the File Menu, a pulldown menu will appear with at least the 
following options:

Printer Setup This allows you to setup the printer in preparation for printing.

Global Search This feature allows you to search your data for a sequence of 
characters anywhere in Ascend.

Speed Dial If you have a modem connected you may press the [F2] key or select
this menu option anywhere in Ascend to "auto dial" phone numbers 
you have indicated as "Speed Dial" numbers in your Address and 
Phone file.    

Exit When you select this option, Ascend will close down and remove 
itself from Windows.    (Same as [ALT]+[F4].)



Printer Setup
This allows you to specify the filler size, filler type, printer, font style, point size, and 
margins you will be using when printing.    Use this before printing or to set default 
printer settings.

Filler Size Select the filler size you will be printing on.

Filler Type If you selected the 5 1/2" x 8 1/2" filler size you may choose 
Technology filler or "Regular" filler.    If you selected the 8 1/2" x 11" 
filler size you may choose "Regular" filler or Plain Paper.

Selected Printer Select the printer you would like to use.    All printers installed in
Windows will be available.

Font Once you select a printer, a list of font styles supported by that 
printer will appear.    Select the font you want Ascend to use when 
printing.

Size Once you select a font, a list of point sizes for that font will appear.    
Select the size you wish to use.    Some fonts have only one size, 
while others have several.    IMPORTANT:    If you select a large point 
size, not as much information will be printed on the page.    Point 
sizes from 6 to 10 are recommended.

Margin Offsets You may adjust the left and top margins so Ascend will print 
correctly on your filler pages.

Sample Font A sample of the font you selected will be displayed.    (Your actual 
printer fonts may differ slightly from the displayed screen fonts.)

OK Accepts the font, size, and margins for the selected filler size, filler 
type, and printer.    You may select different combinations of printer, 
filler size, and filler type and Ascend will restore the fonts, sizes, and 
margins you last assigned for that combination.

Cancel Leaves printer settings unchanged.

Help On-line help for more information on Ascend.

Printer Setup Accesses Windows printer setup.

Make Default Makes the current filler size, filler type, and printer the default.    Font,
size, and margins may be altered without affecting this default 
setting.

Recall Default Returns your default filler size, filler type, and printer with the proper 
font, size and margins.



Global Search
The global search can be accessed from any Ascend module and searches the data 
you indicate for a specific sequence of characters. 

Search For Enter the text you want to search for.

Tasks Check this box if you want to search your tasks.

Task Notes Check this box if you want to search your task notes.

Appointments Check this box if you want to search your appointments.

Appointment Notes Check this box if you want to search your appointment 
notes.

Daily Record of Events Check this box if you want to search your daily record of 
events.

Journal Check this box if you want to search your journal entries.

Phone & Address Notes Check this box if you want to search your Phone and 
Address notes.

Master Task List Check this box if you want to search your Master Task List.

Master Task List Notes Check this box if you want to search your Master Task 
List notes.

Starting Date Enter the starting date for the search.

Ending Date Enter the ending date for the search.

Press the Search button to begin the search.    Each match found will be displayed in 
the scroll list.    You may then select the proper match and Ascend will jump to that 
day's entries.



Speed Dial
If you have a modem connected you may press the [F2] key or select this menu 
option anywhere in Ascend to "auto dial" phone numbers from your Address and 
Phone file.

Each name marked in your phone and address section as a "Speed Dial" number will 
be listed here.    Select the name you wish to dial by double clicking on the name or 
highlighting the name and pressing the OK button.

Select the number (work, home, etc.) you wish to dial, include any prefix or suffix you
wish to include then press the OK button and the modem will dial for you.



Exit
When you select this option, Ascend will close down and remove itself from Windows. 
(Same as [ALT]+[F4].)



Edit Menu
When you select the Edit Menu, a pulldown menu will appear with at least the 
following options:

Undo Undoes the most recent operation and is useful if mistakes are recognized 
immediately.    (Same as [ALT]+[BACKSPACE].)

Cut This option removes the highlighted text and copies it to the Windows 
clipboard.    (Same as [SHIFT]+[DEL].)

Copy This option copies the highlighted text to the Windows clipboard.    (Same 
as [CTRL]+[INS].)

Paste This option copies the clipboard contents to the current cursor location.    
(Same as [SHIFT]+[INS].)

Clear This option removes the currently highlighted text    (Same as [DEL].)



Window Menu
When you select the Window Menu, a pulldown menu will appear with the following 
options:

Save Window Setup Selecting this option will cause Ascend to save your current 
Ascend work space.    This allows you to save any changes you make 
to the size, screen position, or color of any windows.    Upon re-
entering Ascend in the future, the work space will appear as it does 
at the time the setup is saved.

Window Color This allows you to change the background color of the current 
window by mixing different levels of red, green, and blue.    As you 
slide the scroll bar slider, you will see the color change in the 
rectangle below.    Once the color in the rectangle is acceptable, 
select OK and this color will become the active window's background 
color.

Arrange Icons Selecting this option will automatically and evenly arrange any icons 
along the bottom of your screen.

Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes



Save Window Setup
Selecting this menu option will cause Ascend to save your current Ascend work 
space.    This allows you to save any changes you make to the size, screen position, or
color of any windows.

Upon re-entering Ascend in the future, the work space will appear as it does at the 
time the setup is saved.



Window Color
This allows you to change the background color of the current window by mixing 
different levels of red, green, and blue.    

As you slide the scroll bar slider, you will see the color change in the rectangle below. 
Once the color in the rectangle is acceptable, select OK and this color will become the
active window's background color.



Arrange Icons
Selecting this option will automatically and evenly arrange any icons along the 
bottom of your screen.



Options Menu
When you select the Options Menu, a pulldown menu will appear with at least the 
following option:

Preferences This option allows you to customize Ascend to your personal tastes.



Preferences
The Preferences sub-menu is where you customize Ascend by telling it your 
"preferences".

Icon Bar Allows you to display an Icon Bar rather than "loose" icons 
at the bottom of Ascend's window.    You may position this 
bar along any border.    (Lower resolutions will only display 
all Ascend's icons if the Icon Bar is on Top or Bottom.)

Default Print Task Notes on Notes Page Ascend allows notes for each task 
which can be printed on your Daily Record of Events page. 
Each note can be included or excluded from the Daily 
Record of Events.    This item is your default.    You should 
check this item if you usually include task notes on your 
Daily Record of Events page.

Default Include Notes in Monthly Index This option is similar to the Default 
Print task Notes on Notes Page discussed above, but deals 
with including appointment and task notes on your 
monthly index.

Capitalize Task Select this option if you like your tasks and appointments 
to be in upper case letters.

Display Evaluation Select this option to display your evaluation in achieving 
your goals and values.

Break Definition Ascend uses a "break line" to separate items printed on 
your Daily Record of Events.    Click your mouse on the 
down arrow located next to the Break Definition box and 
select the type of break line you would like to use.

Break After Date Checking this option will cause a break line to be inserted 
whenever you insert the System Date.

Break After Time Checking this option will cause a break line to be inserted 
whenever you insert the System Time.

Break Between Notes Prints a break line between each note on your Daily Record
of Events.

Master Task List Categories Enter the names of the five categories you desire 
to use in your Master Task List.

Minutes Between Auto Save Ascend saves your files whenever you quit 
Ascend or switch to another Windows program.    To protect
you from data loss; due to power failure, computer 
problems, etc.; Ascend will save changes every X minutes. 
(Set X to zero to disable the Auto Save.)

# Times to Forward A, B, & C Task Priorities When Ascend "forwards" a task, it 
can also forward that task's priority (A,B,or C.)    Ascend 
keeps track of how may times a task has been forwarded, 



and this field allows you to tell Ascend to only forward a 
task's priority X number of times.

# Times to Forward D Task Priorities This option is the same as # of Times to 
Forward A, B, and C Task Priorities but this option works 
only on your "D" tasks, which are usually tasks you need 
to perform at home or in the evening.

# Times Forwarded Before Master Task List Prompt     Ascend will 
"prompt" you to move a task to the Master Task List after 
you have forwarded the task X number of times.

OK Accepts the currently selected preferences.

More Options To access the second page of preferences, select the More 
Options button.



More Options
Display Quote of the Day Select this box if you would like a random quote from 

your Favorite Quotes file to be displayed when you start 
Ascend.

Display Positive Affirmations Select this box if you would like one of the 
positive affirmations from your personal productivity 
pyramid to be randomly selected and displayed when you 
start Ascend.

Ascend Password You may protect your information by entering a password 
in this field.    If a password is entered, you will be required 
to enter the password every time you start Ascend or 
activate certain modules within Ascend..

Default Phone Descriptions Enter the descriptions of the five phone numbers 
for your Address and Phone file.



Help Menu
When you select the Help Menu, a pulldown menu will appear with at least the 
following options:

Index This option displays an Index of all the help topics in Ascend.

Topic Activates context sensitive help based on the module from which 
Help was selected.

About This option displays copyright and version information for the Ascend
software.

Registration This option displays the serial number, registered user's name, and 
the key number, once this information has been entered.    For help 
on entering this information see Registering Ascend.



Common Keys Used in Ascend
F1 On-line Help
F2 Speed Dial Feature
F4 Goto Date Monthly Calendar    (If Goto is on the menu)
Shift + F1 Prioritized Daily Task List
Shift + F2 Appointment Schedule
Shift + F3 Daily Record of Events
Shift + F4 Address and Phone
Shift + F5 Values and Goals
Shift + F6 Red Tabs
Shift + F7 Master Task List
Shift + F8 Focus
Shift + F9 Weekly View
Shift + F10 Turbo File
Shift + F11 Journal
Shift + F12 Favorite Quotes
Ctrl + Esc Windows Program Selection Scroll Bar
Ctrl + F6 Rotate through Ascend Modules
Alt + Tab Rotate through Windows Programs (fast)
Alt + Esc Rotate through Windows Programs (slow)
Ctrl + F4 Close an Ascend Module Window
Alt + F4 Close and Exit Ascend (if in Ascend)
Alt + F4 Close and Exit Windows (if in Program Manager)
Ctrl+Insert Copy highlighted items into Windows clipboard
Shift+Insert Paste items from Windows clipboard



Printer Considerations
Ascend was designed specifically to be used with the Franklin Day Planner.    As you 
begin using Ascend to print on your Franklin filler pages, you may notice the printing 
is slightly outside the preprinted lines on occasion.    This is due in part to the 
variation in lines and margins on the actual Franklin filler pages and in part to how 
the paper is loaded in your printer.

By being aware of this situation you can use the Printer Setup, to "fine-tune" the 
margins and consistently produce quality printouts.



Prioritized Daily Task List
The Prioritized Daily Task List is one of Ascend's main functions.    You can list your 
Daily Tasks, prioritize them, quickly process them, and track or modify their status 
using Ascend's Options Menu.

You may keep notes on each task.    These notes will move with their respective tasks 
and can be printed on your Daily Record of Events if you choose.    Your tasks can be 
printed in their prioritized order right on your Franklin Day Planner pages.    You may 
select different colors to represent different types of tasks, modify task categories, 
and even track the amount of time spent on tasks with Ascend's timers.

You may enter recurring tasks to remember recurring items and avoid manually 
entering tasks that occur on a regular basis.    

If you prefer more detail, you may select Full View and track your time by 
categorizing your tasks and the amount of time you spend on each task.    You will see
a summary of the amount of time spent on each task priority displayed on a graph.    
If you desire a "hard copy" you may print a Task Statistics Report that summarizes 
this information in report form.



Tasks Menu
The Task menu includes the following options:

File
Printer Setup
Print Tasks, Appointments, & Notes
Print Monthly Index
Task Statistics Report
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear
Insert Task
Delete Task
Copy Task
Move Task

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences
Prioritize
Group Action
Recurring Tasks
Repeat Tasks
Sort Tasks
Special Days
Task Categories
Task Colors
Timers

Goto
Yesterday
Today
Tomorrow
1 Day -
1 Day +



7 Days -
7 Days +
Date

View
Statistics
Full View

Help
Index
Topic
About
Registration



Add Notes
Ascend allows you to include a note with each task or appointment.

Include on Index Page Check this box if you want this note to be included when 
you print your monthly index.

Print on Notes Page Check this box if you want the note to be printed on your
Daily Record of Events.

Index Entry If you select to have include this note on your monthly index, 
you may enter the index entry name.    This field will default to 
the name of the task or appointment.

Find Name This push button is used to merge information from your 
Address and Phone file into your task notes.    When you press 
the button, you will be able to select a name from your Address 
and Phone file.

OK Select the OK button when you are ready to save the note and 
exit.    

Cancel If you wish to exit the note's dialog box without saving your 
changes, push the Cancel button.

Delete If you wish to delete a note from a task or appointment, press 
the Delete button.

In the notes you may also access Ascend's Enhanced Multiple Line Edit Control.



Enhanced Multiple Line Edit Control
Some of the features of the Multiple Line Edit control are described below:    

Several of the controls are toggle buttons that are highlighted when active.    Bold, 
Italics, and Underline are independent of one another and can be on or off in any 
combination.    Left, Center, and Right Justified text are mutually exclusive and only 
one button will be highlighted at a time.

      Bold This toggles between Bold text and regular text on the monitor and the 
printer.    (Same as [CTRL]+[B].)

      Italics This toggles between Italics text and regular text on the monitor and the 
printer.    (Same as [CTRL]+[I].)

      Underline This toggles between underlined text and regular text on the monitor 
and the printer.    (Same as [CTRL]+[U].)

      Left Justify If this button is highlighted the text will be left justified.    (Same as 
[CTRL]+[L].)

      Center Text If this button is highlighted the text will be centered.    (Same as [CTRL]
+[C].)

      Right Justify If this button is highlighted the text will be right justified.    (Same as 
[CTRL]+[R].)

      Insert Time If you wish to insert the current time at the cursor location, press this 
button.    (Same as [CTRL]+[T].)

      Insert Date If you wish to insert the current date at the cursor location, select this 
button.    (Same as [CTRL]+[D].)

      Insert Break If you want to insert a break line at the cursor location press this 
button.    (Same as [CTRL]+[K].)

Mouse users may also take advantage of the Cut, Copy, and Paste features found in 
the Enhanced Multiple Line Edit Control Tool Bar.

      Cut Removes any highlighted text and copies the contents to the clipboard.    
(Same as [SHIFT]+[DEL].)

      Copy Copies any highlighted text to the clipboard.    (Same as [CTRL]+[INS].)
      Paste Copies the contents of the clipboard to the current cursor location.    (Same as 

[SHIFT]+[INS].)



Find Name
To incorporate information from a record in your Phone and Address list, simply start 
typing in the Last Name or Company Name of the record you are looking for.    You 
may also use the mouse to search through the scroll list to find the correct name.    

To incorporate any of the following information from the selected record into the note 
or module in which you are working, simply check its corresponding box and press 
the OK button or [ENTER].

Name Includes the person's name.

Company Includes the company name.

Address Includes the address.

Phone Numbers Includes the phone numbers and their descriptions.

Phone Notes Includes any notes entered for that person in the Address & 
Phone file.



Print Tasks, Appointments & Notes
Ascend will print your Prioritized Daily Task List right on the pages of your Franklin 
Day Planner or even on blank pages if you wish.    

If you are using "regular" Franklin filler pages make sure the Page Date in Ascend is 
the same as the filler date from your Franklin Planner in your printer.    If you are using
Franklin Computer Edition pages or printing on "Plain paper" Ascend will 
automatically print the date on the page for you.    To print your tasks, appointments, 
or notes, pull down the File menu and select Print Tasks, Appointments & Notes.

Print Prioritized Daily Task List Check this option if you wish to print your 
Prioritized Daily Task list.

Print Appointment Schedule Check this option if you wish to print your 
Appointment Schedule.

If both Print Prioritized Daily Task List and Print 
Appointment Schedule have been selected, Ascend will print 
both your tasks and your appointments at one time on the left 
side filler page of a Franklin Day Planner.

Print Daily Record of Events & Notes Check this option if you wish to print your 
Daily Record of Events, Task Notes, Appointment Notes, Journal, 
etc. on your Franklin Daily Record of Events Page.

Lines to Skip If you have already written on your Franklin Day Planner page 
for the selected date, you may specify how many lines you wish
Ascend to skip before printing.    This option is only valid for your
Prioritized Daily Task List and your Daily Record of Events.

Pause between Pages If you select to print either your tasks or your 
appointments (left page) and your notes (right page), you may 
select this option to pause your printer before printing 
subsequent pages.    This allows you to manually load and adjust
these sheets in your printer.

Include Journal with Daily Record of Events Check this option if you desire any 
entries for the current Page Date found in your journal to be 
printed along with the other note items on your Daily Record of 
Events.

Print on Blank Page Occasionally you might ruin a page from your Franklin 
Planner (printer not setup properly, wrong date in printer, paper
jam, etc.).    Should you ruin one of your pages, you may print 
your tasks, appointments, and notes on a blank sheet of paper 
by checking this option.

Printer Setup Use this to verify or alter your printer setup.

Appointment Range If you are using Franklin "Technology" filler, also known 
as Computer Edition Forms, Ascend will allow you to print your 
appointments in one of three ways:

Sequentially Ascend will list your scheduled appointments for that day one 



after another.
22 hour range 30 minute increments where you specify the 22 hour range.
11 hour range 15 minute increments where you specify the 11 hour range.

When you are ready to print, press the OK button.



Print Monthly Index
The Monthly Index is an alphabetized, dated list of any tasks, appointments, or notes 
you have marked to be included on the Monthly Index.    It is useful for identifying 
exact dates of significant occurrences.    

The letter preceding the description indicates the source of the entry.    (A - 
appointments, T - tasks, etc.)    The date following the description is the date where 
the entry is found.

To print your monthly index pull down the File menu, select Print Monthly Index, 
select the desired month, prepare your printer, and select OK.



Task Statistics Report
The Task Statistics Report is useful for analyzing how you are spending your time.  
This report is only meaningful if you are using Ascend's advanced time management 
features by using Full View in the Prioritized Daily Task List module.

This report prints on 8 1/2" x 11" paper and displays the number of tasks by category
and priority and calculates the completion ratios based on: number of tasks, 
estimated hours, and actual hours.

This feature can be used to track how much time is going to different categories you 
have assigned.    (Different projects, clients, etc.)



Edit Task List
One advantage of using an automated planner system, is the ability to easily and 
cleanly edit your Prioritized Daily Task List and keep the list sorted and prioritized.

Insert Task This allows you to enter tasks you may remember after you 
have prioritized your list or to enter tasks that suddenly arise.    
To insert a task, simply move the cursor to the task you would 
like your new task to precede, from the menu select Edit, then 
Insert Task.    Ascend will insert a blank line for the new task 
and automatically re-number all following tasks to preserve 
their prioritized rankings.

Delete Task To delete a task, simply place the cursor anywhere on the row of
the task to be deleted, from the menu select Edit, then Delete 
Task.    Ascend will automatically re-number all following tasks 
to preserve their prioritized rankings.

Copy Task To copy a task to another Page Date, and still leave the task on 
the current Page Date, place the cursor anywhere on the row of 
the task to be copied, select the Edit menu, then the Copy 
option.    The Goto calendar will appear allowing you to select 
the date, or the Master Task List category, you wish to copy the 
task to.

Move Task To move a task to another Page Date, and remove the task from
the current Page Date, place the cursor anywhere on the row of 
the task to be moved, select the Edit menu, then the Move 
option.    The Goto calendar will appear allowing you to select 
the date, or the Master Task List category, you wish to move the
task to.



Prioritize
Ascend "walks you through" the prioritizing process "step by step."    Ascend uses the 
prioritizing methods taught by Franklin International Institute, Inc., and if you are 
familiar with how this method works, you will appreciate the easy approach Ascend 
uses to help you prioritize.

You begin the prioritization process by selecting the Options menu, then selecting 
the Prioritize menu option.

The Unprioritized Task box will list all the current Page Date's tasks that have not 
been completed, deleted, forwarded, or prioritized.

As taught by Franklin International Institute, Inc. the first step in the prioritizing 
process is to label each of your tasks, A, B, C, or D, as described below:

A Vital tasks - tasks you must complete today.    You would suffer significant, 
adverse consequences if you did not complete these tasks today.

B Important tasks - tasks you should do today.    You would not suffer significant,
adverse consequences if you did not.

C Some value tasks.    You could complete them "if you get time".    These are 
less important and not very urgent.

D These are tasks you wish to do on your own time, usually in the evening, and 
will be printed at the bottom of your planner page.

You will notice the first task in the Unprioritized Tasks box is highlighted.    Decide 
whether it is an A, B, C, or D task and click the corresponding button to prioritize the 
task.    You may also highlight all the tasks you would like to move to a particular 
priority then click the corresponding button. (A Tasks, B Tasks,....)

If you come to a task that should not be prioritized because it is completed or you 
want to forward it, etc, simply select the appropriate check box to show the task has 
been completed, forwarded, delegated, etc.

Sometimes you may forget what a task means.    You may use the View Notes button
to view the notes, if any, for that task.    The tasks you wish to see the notes for must 
be highlighted.    If no notes are associated with any highlighted task, you will hear a 
short beep.

Once you have prioritized your tasks as either A, B, C, or D tasks, you will need to 
rank the tasks within their respective categories to put each task in a numerical 
order. (A1, A2, A3,....)

When you are through prioritizing and ranking your tasks, press the OK button to 
return to your task list.



Group Action
You use group action to quickly assign task codes to all of the tasks that have not 
been completed, deleted or forwarded.

To access the group action, pull down the Options menu then select Group Action.

All tasks that do not already have a task code will appear in the upper box labeled 
Tasks that Need Actions.    Select the appropriate action for the highlighted task by
pressing the necessary button (Completed, Forwarded, Deleted, etc.).

The seven smaller buttons for the next seven days of the week are a quick way to 
forward tasks within the coming week without having to use the Goto calendar.    
These seven buttons display the next seven days and change depending on the Page 
Date.

Complete & Copy button is used to mark tasks as completed on the current Page 
Date but still copy it to another date, via the Goto calendar.    This is convenient for 
"ongoing" tasks, or tasks you worked on today but did not complete.

If you want to see any notes you may have with tasks, highlight the tasks then press 
the View Notes button.    The notes for any tasks you have highlighted will be 
displayed one at a time.



Recurring Tasks
A recurring task is a task that occurs at consistent intervals.    Ascend allows you to 
schedule recurring tasks either directly from the Prioritized Daily Task List or via the 
Values and Goals section.

To Add a recurring task, select the Options menu, then Recurring Tasks.    

Task Description Enter the description of the recurring task as you want it to 
appear on your Prioritized Daily Task List.

Default Priority Enter the default priority for the task, A, B, C, or D or leave 
blank for no default priority.

Notes Include any notes you want to always appear with the task.

Est. Time Blocks Enter the number of time blocks you estimate the task will 
require.    This feature is only meaningful in Full View.

Category Enter the task category.    This feature is only meaningful in Full 
View.

Starting Date Enter the date you want this task to start appearing on your 
Daily Task List.

Ending Date Enter the date you want this task to stop appearing on your 
Daily Task List.

Day If you would like the recurring task to appear on a specific date 
in the month, enter the date here.

Month If you would like the recurring task to appear on a specific 
month, enter the month here.

Weekdays Check the weekdays you would like the task to appear on your 
Daily Task List.

Week Number Check the week number you want the task to appear on your 
Daily Task List.    These week numbers correspond to the week 
number in the month.

Save Press this button to save the current recurring task.

Find Press this button to find an existing recurring task.    A dialog 
box listing all your Special Days will appear.    You may highlight 
a particular Special Day and view it or delete it.

New Press this button to    enter a new recurring task.

Delete Press this button to delete the current recurring task.

Prev Press this button to view the previous recurring task.

Next Press this button to view the next recurring task.



Exit Press this button to exit recurring tasks.

Performance Select this check box to display a calendar showing you how 
you have performed with the current recurring task.    A circle 
will appear on every day the task was scheduled.    A check 
mark will appear in the circle on every day you actually 
completed the task.    Some statistics will also be displayed 
below the calendar.



Repeat Task
A "Repeat Task" is a task that needs to be scheduled at a regular interval from when 
it is completed.    Repeat Tasks are different from recurring tasks in that they are only 
re-scheduled after they are completed.    The re-schedule date is based on the 
completion date.    Example:    Get a Haircut may be a repeat task.

To schedule a repeat task, simply add the task to your Prioritized Daily Task List on 
the first date you wish to schedule the task.    After you have entered the task, pull 
down the Task Options menu and then select Repeat Task.    A dialog box will 
appear asking you how many days to wait before re-scheduling this task once it has 
been completed.    You may then enter the correct number of days and select OK.



Sort Tasks
Occasionally you may move your tasks or priorities around and need to re-sort them 
by their prioritized order, you may do this by pulling down the Options menu and 
selecting Sort Tasks.

If you are using a mouse and wish to sort the current day you may double click 
anywhere in the Page Date area of the Tool Bar at the top of Ascend's window.



Special Days
You may designate recurring special days such as holidays, birthdays, anniversaries, 
etc., and nonrecurring special days such as vacations and business trips.    Once 
specified, these days will be designated with an icon on your goto calendar and 
weekly view window, and with an icon and description in the Special Days drop-down 
box on Ascend's Tool Bar.

One purpose for designating Special Days is to alert you to special occasions so you 
may schedule appropriate appointments and tasks on these days.    (Example: you 
probably would not schedule a meeting on Christmas or when you are unavailable 
due to a trip or vacation.)

Special days do not print on your task list.    However, a recurring task can be 
used to associate a task with a special day.    (Example: a recurring task several days 
before a birthday: Buy Birthday present for..., could remind you of the action to be
taken for that special day.)

Description Enter the description of the special day.    (Example Christmas, 
John's Birthday,etc.)

Starting & Ending Dates Enter the starting and ending dates for the special day.    

Day Enter the day of the month of the special day.    (Example: 
Christmas would be 25.)

Month Enter the month number of the special day.    (Example, 
Christmas would be 12.)

Category Select the appropriate category for the special day.    Valid 
categories include:

The closed sign symbolizes a holiday.

The palm tree symbolizes a vacation.
The cake symbolizes a birthday.
The ring symbolizes an anniversary.
The brief case symbolizes a business trip.
The exclamation point is for misc. special days.

Week Days Check the weekdays you want this special day to affect.    (If you specified a 
day other than zero above, these boxes will be disabled since Ascend will calculate the day 
or days.)

Week Number Check the week numbers you want this special day to affect    (If
you specified a day, other than zero, above you cannot check 
these boxes since Ascend will calculate the week number.)

Save Press the Save button when you want to save changes to the 
Special Day record you are working on.

Find This displays a list of all your Special Days.    To select a Special 
Day from the list, press the OK button or double click on the 
desired item.    If you wish to delete one of the displayed Special
Days, highlight that Special Day then press the Delete button.



New Press the New button when you want to lose changes you have 
made to the current Special Day and allow you to enter a New 
Special Day.

Delete Press this button when you want to delete the current Special 
Day record.

Prev Press this button when you want to save the current Special Day
record and bring up the previous Special Day record.

Next Press this button when you want to save the current Special Day
record and bring up the next Special Day record.



Task Colors
Select this option if you wish to assign different colors to different types of tasks.    
This enables you to recognize immediately whether a task is a normal task, a 
recurring task, or a repeat task.    

If you have a color printer you may even print them in distinct colors.    If you choose 
not to use this option you may choose the same color for all tasks.



Timers
Ascend has five timers you may use to better track, and control your time.    Each 
timer is independent of all others and can either count up (elapsed time) or 
countdown (if you specify an amount of time to count down.)    Ascend will notify you 
when a countdown timer has elapsed, as long as you are in a Windows application.

To access the timers, select the Options menu then select Timers.    A dialog box will
appear displaying the status of all five timers. Only one timer can be affected at a 
time.    To select a timer, check its "radio button."    Without a mouse you may use the 
[TAB] and cursor keys, or press [ALT] and the number of the timer you wish to affect. 
(Example: [ALT]+[3].)

If you wish the timer to count down you must enter a value in either the hours 
column, hh under Countdown, or the minutes column, mm under Countdown.    If no 
values are entered in the hh or mm columns the timer will automatically count-up.

The buttons at the bottom of the dialog box apply only to the active timer, the one 
whose radio button is checked, and will have the following effect:

OK Leaves the timers dialog box.

Clear Clears or resets the current timer.

Start Starts the current timer.

Stop Stops the current timer.

Pause/Resume Pauses the current timer if it is running or resumes the current 
timer if it is paused.

Once a timer is started it will display information in the following columns:

Started/Re-StartedThis will show the time the timer was started; or, if it has been 
paused, the time it was restarted.

Status This shows the current status of the timer.    (Running, Paused, 
Stopped...)

Elapsed/RemainingShows the elapsed hours, minutes, and seconds on a regular 
timer.    On a countdown timer it shows the hours, minutes, and 
seconds remaining before it expires.

Blocks This translates the preceding column into time blocks for easier 
use in Ascend.



Goto Menu
The Goto menu includes the following selections:

Yesterday This option changes the current page date to one day before 
the current system date.

Today This option changes the current page date to the current 
system date.

Tomorrow This option changes the current page date to one day after the 
current system date.

1 Day - This option changes the page date to one day before the 
current page date.    (It moves back one day in the planner.)

1 Day + This option changes the page date to one day after the current 
page date.    (It moves ahead one day in the planner.)

7 Days - This option changes the page date to one week before the 
current page date.    It moves back one week in the planner.    In 
Weekly View this option is called    -1 Week.

7 Days + This option changes the page date to one week after the current
page date.    It moves ahead one week in the planner.    In 
Weekly View this option is called    +1 Week.

Date This accesses the Goto Calendar which is a calendar that allows 
you quick access to any date.



Goto Calendar
You may forward tasks using the Goto Calendar, also called the Monthly Calendar.    
This is the same calendar used when you select the Goto/Date menu options.    It 
can also be accessed with the [F4] key if Goto appears in the menu.

Next to some of the dates a small icon might appear (cake, closed sign, briefcase, 
palm tree, etc.) representing a Special Day    These icons help you avoid forwarding 
tasks to days when you may not be available.

You may select the date you wish to forward the task to by double clicking on the 
desired date or by typing in the desired date you wish to forward the task to.

Sometimes it is useful to know what tasks, appointments, and/or special day items 
are on a particular day before forwarding a task to that day.    To view a date's tasks, 
appointments, and special day items, click the mouse on the desired date one time.   
The date will be marked with a highlighted box.    You may now check the View 
Detail box and any tasks, appointments, and/or special day items will be displayed in
the scroll boxes at the right of the calendar.    

Using the calendar, you also have the option of forwarding tasks to your Master Task 
List instead of to a date.    To do this, click your mouse on the down arrow to the right 
of the Master Task List category box.    Your five Master Task List categories will be 
displayed.    Select the category you wish to move the task to then select the OK 
button and the task will be moved to the specified category in your Master Task List.



View Statistics
To view the statistics of a particular task, move your cursor to one of your tasks, pull 
down the View menu and select Statistics.    

This option displays a small dialog box containing misc. statistics about the task.
(Date first entered, forwarded from, days since...)    This is especially useful for finding
"lost" tasks you may have forwarded.



Entering Tasks
To enter a task, simply move to the first empty line under the Prioritized Daily Task 
List column and type in the task.    To move between columns you may either use 
your mouse to click in the desired column and row or you may use the [TAB] key to 
move between columns and your up and down arrow keys to move between rows.    
(The [ENTER] key will move you down a row in the same column.)

Each of the columns are explained below:

 (Task Code) This column specifies the particular code to assign each task.    Valid 
task codes are:

A blank code symbolizes the task has not been acted upon.
This code symbolizes the task has been completed.
This code symbolizes the task has been forwarded to another day.    You may see the 

day to which the task was forwarded by using the View Statistics function.
This code symbolizes the task has been deleted.
This code symbolizes the task has been delegated to another person.
This code symbolizes the task is in process but has not been completed yet.
This code symbolizes the task that was delegated has now been completed.
This code symbolizes the task that was in process has now been completed.

There are three ways to select the appropriate task code for a task:

1. Click in the task code column or press the space bar.    This will bring up 
the Select Task Code dialog box allowing you to choose from the 
available codes.

2. Use the right mouse button and click in the column.    Each click will display
the next task code.    Stop clicking when you reach the code you desire.

3. Use the Group Action feature.

abc This is the prioritization column.    When you prioritize your tasks
with the Prioritize Tasks menu option, this column will fill in 
automatically for you.    You may, however, fill this information in
directly if you desire.

Prioritized Daily Tasks This column is where you enter your task descriptions.

 (Notes) This column indicates if you have entered a note for the task.    If the box 
contains the notes icon, you have entered a note.    If it is blank, there are no notes for the 
task.    To enter or edit the notes for a task, either click in this column or press the space bar 
to activate the Task Notes dialog box.
Columns for Full View Only
Est Number of estimated time blocks the task should take.
Act Actual number of time blocks required to complete the task.
Category This column allows you to specify which category you would like to assign the 
task to.    The default category tasks is "None".    To access the different categories, either 
click the left mouse button in this column or press the space bar when you are in this 
column.    This will activate the Task Categories dialog box.





Rank Tasks
After you have prioritized your tasks into the 4 priorities (A,B,C, or D), you need to 
rank your tasks.    Ranking is the process of determining the precedence of tasks 
within a priority.    For example, which of your A tasks should be A1, A2, A3....

When you see this dialog box, you will see all of your A,B,C or D tasks in the 
Unranked Tasks list box.    Select the task you want to be first and then press the 
Rank 1 button.    This will move the task over to the other side of the dialog box and 
allow you to select the next task.    The Rank 1 button will now change from Rank 1 
to Rank 2.    Continue ranking all of your tasks.    Once you have ranked all of your 
tasks, select the Done button.

You may also select the next task to be ranked by double clicking on the task.



Task Codes
Select the task code you desire to assign to the task in one of the following three 
ways:

1. Click in the task code column or press the space bar.    This will bring up the 
Select Task Code dialog box allowing you to choose from the available codes.

2. Use the right mouse button and click in the column.    Each click will display 
the next task code.    Stop clicking when you reach the code you desire.

3. Use the Group Action feature.

Below is a brief description of valid task codes:

A blank code symbolizes the task has not been acted upon.
This code symbolizes the task has been completed.
This code symbolizes the task has been forwarded to another day using the Goto 

calendar.    You may see the day to which the task was forwarded by selecting View then 
Statistics.

This code symbolizes the task has been deleted.
This code symbolizes the task has been delegated to another person.
This code symbolizes the task is in process but has not been completed yet.
This code symbolizes the task that was delegated has now been completed.
This code symbolizes the task that was in process has now been completed.



Appointment Schedule
Ascend allows you to track your appointments and print them right on your Franklin 
Day Planner pages.    Ascend will warn you if an appointment you are scheduling 
conflicts with another.    Appointments are similar to Tasks in that you can schedule 
recurring appointments, and attach notes to your appointments, which can be printed
on your Daily Record of Events.    Unlike tasks you can set an alarm for any 
appointment and "snooze" the alarm if you need more time when it sounds.

See Also:

Changing the Page Date
Entering Appointments
Adding Notes to an Appointment
Setting Alarms
Moving Appointments
Copying Appointments
Recurring Appointments
Changing Appointment Colors



Appointments Menu
The Appointments menu includes the following options:

File
Printer Setup
Print Tasks, Appointments, & Notes
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear
Cut Appointment
Copy Appointment
Paste Appointment

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences
Recurring Appointments
Appointment Colors

Goto
Yesterday
Today
Tomorrow
1 Day -
1 Day +
7 Days -
7 Days +
Date

Help
Index
Topic
About
Registration





Entering Appointments
To enter an appointment, simply move to the desired time and enter in a description 
for the appointment.    If the appointment is one that occurs on a regular basis you 
may prefer to enter the appointment once as a recurring appointment and let Ascend
automatically enter the appointment for you.

To move up and down the schedule, you may:

1. Use the scroll bar to the right of the schedule to move to the time you desire.
2. Use the up and down arrow keys or Page Up and Page Down keys on the 

keyboard to move to the line you desire.
3. Use the mouse to click on the line you desire.

The five columns of the appointments window are described below:

Time This displays the time, in 15 minute increments, at which 
appointments may be entered.

Appointment Schedule This is where you enter a description of the appointment.

 (Alarm) This is the alarm column where you may set alarms for your appointments.
 (Notes) This column allows you to attach a note to an appointment.
 (Time Blocks) This column allows you to specify how many time blocks the 

appointment will take.



Setting Alarms
To set an alarm for an appointment, click your mouse in the alarm column on the row 
of the appointment or tab your cursor to the correct column on the desired row and 
press the space bar.    You may either enter a time directly or you may use the up and 
down arrow buttons to change the default time.

If you desire the alarm to give you some advance notification, you may set the early 
warning.    For example, if you had a 1:00 appointment, but wanted 10 minutes to get 
to the meeting, you would set a 1:00 alarm with 10 minutes Early Warning.

When the alarm does sound, you will be given the option to snooze the alarm to 
sound again at a later time.



Editing Appointments
Several editing features allow you to easily cut, copy, and paste appointments to 
different places or even different dates, on your Appointment Schedule.

Cut Appointment Place the cursor on the row of the appointment you wish to 
remove then select this option.    The appointment will be 
removed from the Appointment Schedule but is in memory in 
case you decide to paste it somewhere else.    (Only the most 
recently cut appointment can reside in memory so if you have 
multiple cuts to perform, be sure and paste each appointment 
before cutting the next appointment.)

Copy Appointment Place the cursor on the row of the appointment you wish to 
copy then select this option.    The appointment will remain on 
the Appointment Schedule but is also now in memory so you 
can paste it somewhere else.

Paste Appointment Place the cursor on the row where you wish to paste the 
appointment, then select this option.    If there is an 
appointment in memory it will be placed on the line where your 
cursor is.

Move Appointments To move an appointment to another date or time, put the
cursor on the appointment you wish to move, pull down the 
Edit menu, and select Cut Appointment or Copy 
Appointment, depending on if you want the appointment to 
still appear in its original location.    (The appointment is now in 
a temporary location in your computer's memory.)    Now, move 
your cursor to the location where you wish to move the 
appointment to, even on a different page date, pull down the 
Edit menu, and select Paste Appointment.    The appointment
reappears in its new location.



Recurring Appointments
A recurring appointment is an appointment that occurs at regular intervals.    To Add a
recurring appointment, select the Options menu, then Recurring Appointments.

Description Enter the description of the recurring appointment as you want 
it to appear on your Appointment Schedule.

Blocks Enter the number of time blocks the appointment will require.    
(15 minutes = 1 Time Block.)

Notes Include any notes you would always want to appear with the 
appointment.

Time Enter the scheduled time of the appointment

Alarm Check this box if you want an alarm with the appointment

Early Warning Enter the number of minutes, up to 60, before the actual 
appointment you want the alarm to sound.

Start Date Enter the date you want this appointment to start appearing on 
your Appointment Schedule.

End Date Enter the date you want this appointment to stop appearing on 
your Appointment Schedule.

Day If you would like the recurring appointment to appear on a 
specific date in the month, enter the date here.

Month If you would like the recurring appointment to appear only 
during a specific month, enter the month here.

Weekdays Check the weekdays you would like the appointment to appear 
on your Appointment Schedule.

Weeks Check the week number you want the appointment to appear 
on your Appointment Schedule.    These week numbers 
correspond to the week number in the month.

Save Press this button to save the current recurring appointment.

Find Press this button to display a list of existing recurring 
appointments.    You may then select the one you desire.

New Press this button to enter a new recurring appointment.

Delete Press this button to delete the current recurring appointment.

Prev Press this button to view the previous recurring appointment.

Next Press this button to view the next recurring appointment.

Cancel Press this button to exit recurring appointments.



Help This will provide on-line help about recurring appointments.



Finding Recurring Items or Special Days
Select this option if you wish to find an exisiting Recurring Appointment, Recurring 
Task, or Special Day.    

You may use the mouse or cursor keys to highlight the desired item then select OK.    
Mouse users can double-click on the desired item and Ascend will display the 
information pertaining to that item.



Appointment Colors
Select this option if you wish to assign different colors to different types of 
appointments.    This enables you to recognize immediately whether an appointment 
is a normal appointment, a recurring appointment, or an appointment scheduled over
the network.

If you have a color printer you may even print them in distinct colors.    If you choose 
not to use this option you may choose the same color for all appointments.



Daily Record of Events
Ascend allows you to enter and save notes into your Daily Record of Events and then 
print these items in your Franklin Day Planner.    A quick search routine allows you to 
find entries quickly in your Daily Record of Events.    Information from your Address 
and Phone file can be merged into an entry, thus allowing you to quickly include 
phone numbers, addresses, directions, etc., with an entry.

The Daily Record of Events is basically a mini word processor where you may record 
phone conversations, thoughts, ideas, anything!    The Daily Record of Events are 
recorded entirely in a window using the Enhanced Multiline Edit Control which allows 
you to instantly include the Time, the Date, a Break line, or information about an 
entry found in your Address and Phone file.    You may also format the text using bold,
italics, underline, right justify, left justify and center text.    For additional features see 
the Enhanced Multiline Edit Control.

See Also:

Adding Entries for Your Monthly Index
Edit Menu
Enhanced Multiline Edit Control



Daily Record of Events Menu
The Daily Record of Events menu includes the following options:

File
Printer Setup
Print Tasks, Appointments, & Notes
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear
Insert Name

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences
Index Entries

Goto
Yesterday
Today
Tomorrow
1 Day -
1 Day +
7 Days -
7 Days +
Date

Help
Index
Topic
About
Registration



Adding Entries for Your Monthly Index
Indexed entries make finding particular entries easier.    If you would like to create an 
entry to be included on your Monthly Index for something in your Daily Record of 
Events, simply select the Index menu and a dialog box will appear asking for the 
name of the index entry.    

There is a new Daily Record of Events for each day.    If you would like to see all 
entries already used on that day you may use the cursor keys or the mouse to access
the drop down list box.



Address and Phone
Ascend maintains a categorized address and phone directory that can be printed for 
your Franklin Day Planner.    You may also print mailing labels for your entries.

Phone numbers can be dialed directly from the computer if you have a modem.    
When dialing a number for you, Ascend will automatically send the appropriate 
prefix, and/or suffix, codes for in-state, out-of-state, and local calls.    A "speed dial" 
feature makes it extremely easy to dial certain numbers you call frequently.    

A "filter" feature allows you to quickly view or print only a select group of entries, 
such as all golf courses, all hotels in California, all board members, etc.    If desired, a 
"VIP" feature can be used to help secretaries screen incoming calls.    

Ascend's Import and Export features also make it easy to exchange data with other 
programs you may be using.

See Also:

Adding an Entry
Exporting Phone Records
Filter
Finding and Editing a Record
Importing Phone Records
Index
Modem Settings
Phone and Address Data Entry
Pasting Name to Clipboard
Printing Phone Entries
Print Labels



Address and Phone Menu
The Address and Phone menu includes the following options:

File
Printer Setup
Print Tasks, Appointments, & Notes
Print Labels
Global Search
Speed Dial
Import
Export
Exit

Edit
Copy Name
Add Name
Edit Name
Delete Name

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences
Dial
Modem
Phone Categories

View
Index
Set Filter
Use Filter

Help
Index
Topic
About
Registration



Editing your Address and Phone File
The following options will help you maintain your Address and Phone File.

Add Name This allows you to add a new name to your file.    You may also 
press [INS] to add a new record.

Edit Name This allows you to edit an existing phone record.    Simply 
highlight the record, select Edit, then Edit Name.    You may 
also highlight the record then press [ENTER].

Delete Name This allows you to delete an existing phone record.    Simply 
highlight the record to be deleted, select Edit, then Delete 
Name.    You may also highlight the record then press [DEL].    
You will be asked to confirm the deletion.



Adding a Name to your Address and Phone File
To add a name to your Address and Phone file, pull down the Edit menu then select 
Add Name.    (You may also press the Insert key to add a new entry.)    Ascend will 
then proceed to the Phone and Address Data Entry screen.    Most of the fields in this 
dialog box are self-explanatory, with the following added detail:

Category Ascend allows you to categorize your Address and Phone 
entries, if desired.    You may then use Ascend's "filter" feature 
to find all golf courses, restaurants, hotels, business associates, 
etc.    To categorize an entry, click your mouse on the down 
arrow to the right of the category input box.    A box will appear 
showing all of the categories you have entered so far.    You may
either use your mouse to select an existing category, or you 
may type in a new category if needed.

Description When adding a new record, the five phone number Description
fields will default to what you have specified in your 
preferences.    You may keep these defaults or enter new ones.

VIP Check this box if the entry is a VIP.    You could then use the filter
to print a listing of your VIPs for your secretary.    Your secretary 
could then interrupt you in meetings if a VIP calls or visits.

Speed Dial If you have a modem and are planning on using Ascend as an 
auto dialer, check this box for numbers you call frequently.    
Entries with the Speed Dial box checked can be called quickly 
from anywhere in Ascend by pressing the F2 function key.

List by Company (See List by Name)

List by Name When Ascend displays your entries on the directory screen (the 
one that looks like a phone book), it will list them in alphabetical
order.    If you would like the entry you are adding to be 
displayed based on the last name, check the List By Name 
box.    If, however, you would like the entry to be listed by the 
company name, check the List by Company box.    If you 
would like to have the entry listed by both the last name and 
the company name, check both boxes.

Print The Print button can be selected to quickly print all of the 
information in the current record you are editing. 

Dial Select this button to quickly dial (using your modem) the 
current record you are editing.



Editing a Record in your Address and Phone File
To move from page to page on the phone directory screen, you may do one of the 
following:

1. Click your mouse on the letter tab for the page you desire.
2. Enter the desired letter by typing it in the Finding box.
3. Use the right and left arrow keys on the keyboard to page through your 

listings.

To select an existing record for editing or viewing, simply move your cursor to the 
desired record and press [ENTER] or double click on the record's name with your 
mouse.

To quickly search for a particular name, you may type the name in the Finding box, 
and Ascend will search for the name as you type.    When you arrive at the desired 
name, press [ENTER] to edit or view the record.

For more information on the various fields see Adding a Name to your Address and 
Phone File.



Deleting a Name from the Address and Phone File
To delete an existing record from the Address and Phone module just highlight the 
record you wish to delete, select Edit then Delete Name.    You will be asked to 
confirm the deletion.



Phone Views
Index If you would rather view all of your entries alphabetically in one scroll list 

instead of one scroll list per letter, select Index on the menu bar.    To return 
back to the normal display method, select Index again.    Selecting this 
option will toggle you between the two viewing modes.

Filter You may set up a "filter" in Ascend's Address and Phone module to exclude 
individuals from your index listings and printouts who do not meet certain 
criteria.    To enter your filter criteria, pull down the View menu and select 
Set Filter.    A screen will appear exactly like the Address and Phone dialog 
box.    Enter in any criteria you wish to filter by and then press OK.    

Once you have set your filter's criteria, you must make sure you have turned
the filter on.    There are two ways to do this:

1. Select Use Filter from the View menu.    (Note: If there is a check 
mark by the Use Filter menu option, then the filter is already on and 
selecting it again will turn it off.)

2. Check the Use Filter box at the bottom of the Address and Phone 
directory screen.

To turn the filter off, repeat one of the above options.

To reset your filter's criteria, select Set Filter from the View menu and 
select the Reset push button.    You may tell your filter criteria has been 
reset and is currently empty if the Use Filter box under your Address and 
Phone directory has been shadowed.



Dial
If you have a modem installed you may use the Ascend's Dial feature in the Address 
and Phone file.    To dial a number from Ascend simply highlight the person or 
company you wish to call, select Options then Dial.    A dialog box will appear 
displaying all the phone numbers associated with the listing you have selected.    You 
may include a prefix or suffix to dial with the number then double click on the 
number you wish to dial, or highlight it then select the OK button, and the modem 
dial the number for you.



Modem Settings
If you have a modem and desire to use it with Ascend as an auto dialer, select the 
Options menu option then the Modem menu option to set Ascend's modem 
configuration.

After setting the Baud rate, Data Bits, Stop Bits, Parity and Comm Port for your 
particular modem you may select to include some prefixes and suffixes.

Ascend will automatically send a prefix and/or suffix before certain types of calls.    
These prefixes and suffixes can be set from the Modem menu option.

Ascend automatically detects if a call is Local, In State, or Out of State by how the
number is entered in the Address and Phone file:

1. If a phone number is 8 characters or less (including the hyphen), Ascend 
assumes the number is Local.

2. If the phone number is 10 characters or less but begins with the number 1, it 
assumes the call is In-State.

3. If the phone number is 11 characters or more and begins with the number 1, it
assumes the call is Out-of-State.



Printing Phone and Address Lists
To print your directory for use in your Franklin Day Planner, from the menu select File
then Print you will need to select the following options:

Index Listing This prints only an alphabetical listing of all selected Names 
with their associated numbers.

Complete Listing with Notes This prints an alphabetical listing of all selected 
Names with all the information entered in the Address and 
Phone file.

Complete Listing without Notes This prints an alphabetical listing of all selected 
Names with all information except notes.    (Name, Company, 
Address, Phone numbers, etc..)

Use Filter Check this box if you desire your printout to only include those 
records that meet the criteria you have set up in the filter.

Pause Between Pages Check this box if you want the printer to pause between 
each page.

Page Break Between Letters Check this box if you want the listings for each 
letter to begin on a new page.    (If you want your names to print
on the fewest number of pages possible, do not check this box.)

Starting and Ending Enter a starting and ending letter for your report.

Offset Margins Check this box if you want Ascend to automatically flip between
the right and left pages.    (You specify which side of the page 
you wish to begin the report on.)

Start on Right Hand PageSelect which type page you wish to begin printing on.

Start on Left Hand Page Select which type page you wish to begin printing on.

Printer Setup Push this button if you wish to alter any printer settings before 
printing.

Select the OK button when you are ready to print.



Label Printing
To print labels based on data in Ascend's Address and Phone file, you may use 
Ascend's print label routine.    Select this option from within the Address and Phone 
module by selecting File from the menu then Print Labels.    You may also print a 
label for a single entry from within that entry.by selecting Print then Print Mailing 
Label

Ascend will print labels in several formats based on your printer and the label sheet 
you are using.    You may set a filter to print only selected labels and choose the order
for the labels to be printed.    Below is a description of the options available in the 
Print Label routine:

Label Type Select the type of sheets you wish to print the labels on.    You 
may print on One Across Tractor Feed sheets, on Three 
Across Tractor Feed sheets, or on Three Across Laser 
Sheets.    

If you select either Tractor Feed you should adjust the printer 
before printing.    If, in addition to tractor feed, you selected 
three across, you should also indicate the column where you 
would like the labels to begin printing.

If you select Laser Sheet Ascend will recall where the last label
was printed and begin at the next position.    You may also 
suppress printing on the top or bottom row of the sheet.

Include Top Row / Include Bottom Row These options are available only if 
Three Across Laser Sheet is selected, and allows you to avoid 
the non-printing area of many laser printers.

Starting Location on Page Displays a graphical representation of where 
Ascend will start printing labels.    You may select a different 
starting location by using the cursor keys or the mouse.

Use Filter If you have previously set a filter you may choose to use the 
filter.

Print Each Label X Times Indicate the number of times you wish each label to be 
printed.    (This is useful for return address labels, etc.)

Sort By: If you choose to use sorting, you may sort by Last Name, 
Company, City, or Zip.

Starting: / Ending: If you selected to sort by either Last Name, or Company, you 
may set the starting and ending range to print.    Only Company 
listings will be sorted and printed if you sort by Company and 
only Last Name listings will be sorted and printed if you sort by 
Last Name.    

EXAMPLE:    If one of your entries is ABC Corporation entered in 
the Company field with no Last Name and you select to sort by 
Last Name and print the range from A to Z , the ABC 
Corporation will not be printed.



Regular Label Margins (Portrait) By selecting this option the label routine 
will assume the printer is set in portrait mode.    Use this for 
regular label sheets or tractor fed labels.

Envelope Margins (Landscape) By selecting this option the label routine will 
assume the printer is set in landscape mode.    Use this for 
single or multiple envelope printing.

Left / Top Margin These margin settings are independent of and will override your
Printer Setup margin settings each time you print a label    
These margins should be adjusted so the labels are printing in 
the correct place on the page.

Printer Setup    (Button) This displays the printer that will print your labels and 
allows you to change the printer setup before printing.

OK      (Button) This confirms your choices and begins label printing.    Same as 
pressing the [ENTER] key.

Cancel    (Button) This allows you to quit the dialog box without printing.    Same 
as pressing the [ESC] key.

Help    (Button) This provides context sensitive help about printing labels.



Importing Phone Records
To import data to Ascend's Address and Phone file, you may use Ascend's import 
routine.    Ascend will import ASCII text files in several common formats.    Most fall 
into the broader groups of Character Delimited files and Line Delimited files as 
described below:

Character Delimited This is the more common of the two styles and allows 
more flexibility in preparing the file.    Ascend interprets 
character delimited files as different fields separated by a 
Delimiter with each record occupying its own line.    The 
delimiter may be any ASCII value or character.    The comma is 
a commonly used delimiter and the non-printing character Tab 
is used as a delimiter by some spreadsheet export routines.    

NOTE: Ascend will strip out any quotes in the import file before 
importing.    A sample comma delimited file might look like this: 
"Last Name","First Name","Company","Title", etc.

Line Delimited This style assumes a separate line for each field.    Ascend 
separates one record from the next simply by the number of 
fields (lines in this case) associated with each record, so if a 
record doesn't have information in one of its fields it is 
important to leave a blank line.    

Example: If you select to import nine fields, every ninth line will
start a new record.    If one of your records lacked information 
you would leave blank lines in the appropriate places to 
maintain the field integrity of all subsequent records.

To use this routine, pull down the File menu and select Import.    The Import Names 
dialog box will appear.    The functions of the Import Names Dialog Box are described 
below.

Import File: Lists the file name to import.    Upon entry the default is a TXT 
extension.    You may either type in the file name if the path is 
correct or you may browse until you find the correct drive, 
directory, and file.

Path Displays the current drive and directory to search.

Files    (List Box) Lists all the files in the current drive and directory that match 
the Import File criteria set above.    All sub-directories of the 
current directory will be displayed as well as all available drives.

Remove Will remove the highlighted field, if any, appearing below the 
Field button.    The same effect may be achieved by double 
clicking on the field you wish to remove.

Field Highlighting the desired field below the Remove button then 
pressing this button allows you to select the fields you wish to 
import.    They should be listed in the same order they appear in 
the import file.    If there are fields in the import file that are not 
listed below the Remove button, the Skip A Field selection 
should be used in their place.



Import Format This drop-down list box allows you to choose the type of file you
are importing.

Delimiter If you have selected a Character Delimited file you must also 
define the delimiter.    You may do this by typing in the ASCII 
value of any printing character, by typing in the actual 
character, or by selecting either Comma or Tab from the drop-
down list box.    (Example:    To select a comma delimited file the 
user could do nothing, since comma is the default, type in 
comma, type in 44, or select "," from the list box.

# of Lines to Skip at the Beginning of the File This is useful if the 
file to be imported includes a line of field descriptions before 
the actual data to be imported.    Spreadsheets often export 
their files with a line describing the fields to follow.

Import    (Button) This starts the actual import process.    (Same as pressing 
[ENTER] with field names defined and a valid import file name.)

Ascend will copy the new records from the import file into your Address and Phone 
file, adding the new records to any records you may already have.



Exporting Phone Records
To export data from Ascend's Address and Phone file, you may use Ascend's export 
routine.    Ascend will export ASCII text files in several common formats.    You may 
append to, or add to the end of, an existing export file you create using Ascend.    By 
using the Filter feature of Ascend you may customize the file to include only those 
records you choose.

When you create an export file you will have to choose the file format, the delimiter, 
and whether to Overwrite or Append to the existing file.

If you choose to export to a file that already exists Ascend will ask you if you wish to 
overwrite, or replace, the existing file or if you wish to append to, or add to, the 
existing file.

To use this routine, pull down the File menu and select Export.    The Export Names 
dialog box will appear.    The functions of the Export Names Dialog Box are described 
below.

Export File: Displays the name of the file you wish to export.    The default 
searches for a file with a .TXT extension.    You may type in a 
new file name or select an existing file, if you have used the 
Export routine previously to create an export file.

Path Displays the current drive and directory where you wish to 
create the file.

Files    (List Box) Lists all the files in the current drive and directory that match 
the Export File criteria set above.    All sub-directories of the 
current directory will be displayed as well as all available drives.

Remove Will remove the highlighted field, if any, appearing below the 
Field button.    The same effect may be achieved by double 
clicking on the field you wish to remove.

Field Highlighting the desired field below the Remove button then 
pressing this button allows you to select the fields you wish to 
export.    The fields should be listed in the same order you wish 
them to appear in the export file.    If you wish to insert a blank 
field to allow for fields you may use in other programs that don't
appear in Ascend, use the Skip A Field selection in their place.

Export Format This drop-down list box allows you to choose the type of file you
wish to export.    You may select from the following pre-defined 
types:

Character Delimited - allows you to define the delimiter you 
wish to use.

Comma Delimited - Inserts a comma between each field and 
starts each new record on a new line, 

Comma/Quotes Delimited - Same as comma delimited but 
surrounds each field with quotes, this is usually safer to use for 
comma delimited export files since it allows you to have 



commas within your fields. 

Line Delimited - Separates each field of each record with a new 
line.    New records are also started on a new line.

Tab Delimited - Separates each field of a record with a tab and 
each record occupies one line.    Useful for exporting into 
spreadsheet and other programs.

Delimiter If you have selected a Character Delimited file you must also 
define the delimiter.    You may do this by typing in the ASCII 
value of any character, by typing in the actual character, or by 
typing Tab.    (Example:    To select a comma delimited file the 
user could do nothing, since comma is the default, type in 44, 
or type in ",".

Use Filter By selecting this check box, only the files that match the filter 
you have defined will be exported.

Export    (Button) This starts the actual export process.    (Same as pressing 
[ENTER] with field names defined and a valid export file name.)



Printer Orientation Verification
If you receive this dialog box, the routine you have used to print from within Ascend 
is expecting a different printer orientation than you currently have selected.    The two
orientations are described as follows:

Portrait Portrait Mode is the usual print mode Ascend expects, it is also 
known as "tall mode."

Landscape Landscape Mode is also known as "wide mode."    An example of
Ascend expecting landscape mode is when you are printing 
envelopes from the Address and Phone module.

The dialog box will have the following Configure Printer options:

Auto Configure Printer (Temporary) By selecting this button Ascend will 
temporarily configure the printer driver for the orientation mode
it needs.    Once printing is completed the printer driver will 
return to its previous orientation setting.

Auto Configure Printer (Permanent) By selecting this button Ascend will 
configure the printer driver for the orientation mode it needs.    
This change becomes "permanent" for all subsequent printings 
in all Windows applications.

Configure Printer Manually By selecting this button Ascend will display the 
printer drivers' Setup dialog box.    This will allow you to 
manually configure the printer driver to the desired orientation 
mode.    The changes made here are "permanent" for all 
subsequent printings in all Windows applications.

Continue With Current Printer Settings Selecting this button will cause 
Ascend to continue with the print routine even thought it is not 
the usual orientation for the current print job.

Cancel    (Button) Aborts the current print routine.    Same as [ESC] key.



Copy Name
This allows you to copy information related to the currently highlighted Address & 
Phone entry to the Windows clipboard for easy pasting elsewhere.    (You may also 
highlight an entry then use [CTRL]+[INS].)    

Ascend will then display a dialog box with the information described below.    To 
incorporate any of the following information from the selected record to the clipboard
simply check its corresponding box and press the OK button or [ENTER].

Name Includes the person's name.

Company Includes the company name.

Address Includes the address.

Phone Numbers Includes the phone numbers and their descriptions.

Phone Notes Includes any notes you may have entered for that person in the 
Address & Phone file.



Values and Goals
The real power of Ascend is seen in the Values and Goals module.    This module 
allows you to enter your Personal Productivity Pyramid, or Personal Constitution, as 
taught by the Franklin International Institute, into your computer.    Ascend outlines 
your Governing Values, Long-Range Goals, and Intermediate Goals in a logical 
pyramid which can then be printed for your Franklin Day Planner.    Ascend allows you 
to evaluate yourself in each area of your Personal Constitution on a rating scale of 1 
to 10 and then automatically introduces specified items from your Intermediate Goals
into your Prioritized Daily Task List.    

The real power is in automatically including goals that need your attention onto your 
Prioritized Daily Task List.    You may even view a progress report on how well you are 
doing.    Because of the structured system employed by Ascend, creating your 
Productivity Pyramid is easy and fun.    (If you need to edit it later, doing so is easy.)

See Also:

Values and Goals Pyramid
Attaching Intermediate Goals to Your Task List
Edit Evaluation
Print



Values and Goals Menu
The Values and Goals menu includes the following options:

File
Printer Setup
Print
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences
Goals Evaluation

Help
Index
Topic
About
Registration



Values and Goals Pyramid
The goal setting process, as explained by Franklin International Institute, Inc., uses 
the Productivity Pyramid which consists of four levels:

 1. Governing Values

 2. Long Range Goals

 3. Intermediate Goals

 4. Daily Tasks

Ascend allows you to enter these goals and values at all four levels where each 
successive level is based on the previous level in a pyramid or "tree" approach.    For 
example, someone could have 10 Governing Values, 50 Long Range Goals (an 
average of 5 per value), and 250 Intermediate Goals (an average of 5 per Long Range
Goal). 

To enter items under each level, select the Add button.



Attaching Intermediate Goals to your Daily Task List
After you have added the first three levels of your pyramid: Values, Long Range 
Goals, and Intermediate Goals, you may introduce some of your intermediate 
goals into your daily task list.    The average person will have from 100 to 300 
Intermediate Goals.    It is not realistic to work on all your Intermediate Goals at once. 
You should evaluate your goals often and work on two or three of your intermediate 
goals at any given time by introducing items from these goals to your Prioritized Daily
Task List.

To have items from your Intermediate Goals appear on your task list, select the Add 
key from the dialog box of the Intermediate Goal you wish to "work on".    A screen 
will appear that looks and functions exactly like the Recurring Tasks feature.    The 
only difference is    this recurring task will be attached to your Intermediate Goal.



Edit Evaluation
Ascend allows you to evaluate yourself by rating each of your Intermediate Goals on 
a scale of 1 to 10 (1 being poor and 10 being excellent).    Ascend uses your 
Intermediate Goal ratings to calculate a rating for each of your Long Range Goals.    
Ascend then uses the calculated rating from your Long Range Goals to calculate a 
rating for each of your Values, and then Ascend calculates one overall rating for your 
entire life based on the ratings of your Values.    These ratings will be displayed at the 
top of the current goals' windows, if you selected Display Evaluation in your 
preferences.

This approach is generally accurate because how well you are doing in your life is a 
factor of how well you are doing in each of your Governing Values; and how well you 
are doing in each of your Values is based on how well you are doing with your Long 
Range Goals; which in turn is based on how well you are doing with your Intermediate
Goals.

To evaluate your Intermediate Goals, select Options then Goals Evaluation from 
the menu.    This will bring up a list of all of your Intermediate Goals.    As you scroll 
through each of your Intermediate Goals, you will see the evaluation for that goal in a
box below where you may change it.    (Double clicking on the goal will allow you to 
instantly edit the evaluation.)

Select the OK button when you are done changing your intermediate goals' 
evaluations.



Printing Values and Goals
Select File    then Print from the menu to print your Values and Goals on Franklin Day
Planner forms.    Each section of values and goals prints on corresponding Franklin 
forms.

If you are on the "Personal Constitution" section, selecting the Print menu option will 
print all of your Governing Values on the "Values" sheet in your Planner.

If you are editing an existing Governing Value, selecting the Print menu option will 
print only that Governing Value on the "Values" sheet in your Planner.

If you are editing an existing Long Range Goal, selecting the Print menu option will 
print only that Long Range Goal, with its corresponding Intermediate Goals under it, 
on the "Goal Planning" sheet in your Planner.



Red Tabs
The Red Tabs module allows you to quickly enter, store, and print information with 
your computer -- a mini word processor, only faster.    To accomplish this the Red Tabs 
utilize the Enhanced Multiline Edit Control for formatting text.    

The Red Tabs module is used just like red tabs in the Franklin Day Planner -- a catch-
all for misc. items.    The numerous uses for Red Tabs are limited only by your 
imagination.    Following are just a few examples of some Red Tab uses:

* A wish list of books you would like to read
* Gift ideas for your spouse and others
* A list of items to take when you travel
* A list of items to take when your family goes camping
* Business ideas
* Shopping lists
* Things to ask your boss when he calls from out of town
* A back-up log of when you backed up your data files
* And on, and on, and on...

To create, edit or delete a Red Tab use the File menu or review the Red Tabs File 
Menu for more information about Red Tabs.

See Also:

Red Tabs File Menu
Red Tabs Edit Menu
Printing Red Tabs
Searching for Text in the Red Tab Files



Red Tabs Menu
The Red Tabs menu includes the following options:

File
New
Open
Save
Save As
Delete
Printer Setup
Print
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear
Find
Find Next

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences

Help
Index
Topic
About
Registration



Red Tabs File Menu
Each Red Tab item is kept is a separate file.    To Add, Edit or Delete files from your 
Red Tabs, you need to use the File menu option.

New This option clears the Red Tab screen and allows you to create a new Red
Tab item.

Open This option allows you to find an existing Red Tab item and open it up for 
editing.

Save This option saves any changes you make to a Red Tab item.    If the item 
is a new Red Tab item, you will be prompted to type in the Red Tab's 
description before saving the file.

Save As This option allows you to save the current Red Tab item into a new Red 
Tab.    You will be prompted to enter in the Red Tab's new description 
before saving the file.    You will need to use this option when changing a 
Red Tab's description.

Delete This option allows you to delete an existing Red Tab.



Printing Red Tabs
You may print out your red tabs by selecting the Print menu option.    The red tab will
be printed on plain white paper and will print according to the planner size you are 
using.    The formatting you see in the red tab will be reflected in the printed copy.    
The following options add additional convenience when printing Red Tabs.

Pause Between Pages Selecting this option will cause Ascend to prompt before 
printing each subsequent page, allowing you to prepare the 
printer for the next sheet.

Print Page Numbers Selecting this option will cause Ascend to print page 
numbers at the bottom of each page you print.



Searching for Text in the Red Tab Files
You may use the Edit menu option and the Find sub-option to find text in your red 
tab file.    

Search For Enter the text you desire to search for.

Case Sensitive If you desire your search to be case sensitive, check this 
button.

From Beginning of File If you desire the search to start at the beginning of the 
file, check this button.    Otherwise the search will begin from
the current position in the file.

Select the OK button to begin the search.

You may use the Edit menu option and the Find Next sub-option, or use the [F3] 
key to repeat the last find operation.



Opening Red Tab Files
Select the Red Tab file you desire to edit and press the OK button or double click on 
the desired file.

If you desire to delete one of the Red Tab files you see in the list, simply highlight the 
Red Tab item and press the Delete button.



Master Task List
Ascend allows you to have five different Master Task List categories where you may 
temporarily "store" tasks you would like to do someday; but, you don't want to 
schedule on a particular day yet -- kind of a "someday when" list.    The Master Task 
List is like a "back burner" and is a handy feature for storing tasks you don't want to 
forget, but know you don't have time to complete in the near future.

You may easily and quickly move tasks from your Prioritized Daily Task List to the 
Master Task List and vice versa.    In fact, Ascend will even prompt you to move a task
to the Master Task List after you have forwarded it the number of times you specified 
in your Preferences.

There are five different categories in your Master Task List.    To switch between 
categories, click on one of the big arrows to either side of the category name box or 
use the Goto menu.



Master Task List Menu
File

Printer Setup
Print
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear
Delete
Move

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences

Goto
-1 Category
+1 Category
Work
Home
Church
Misc A
Misc B

Help
Index
Topic
About
Registration



Print
Ascend will print the Master Task List category you are currently in, when you call the 
print routine, on a blank sheet of paper.    The printout size will vary according to the 
filler size you specify in your Printer Setup.    

You can also indicate to Print on Right Side Page or Print on Left Side Page to 
print on the side of the page that best suits your needs.



Edit Master Task List
Delete To delete a task from your Master Task List place the cursor anywhere on 

the row of the task you wish to delete and select this menu option.    
Ascend will ask for confirmation before deleting the task.

Move This allows you to move the current task to your Daily Prioritized Task List.  
To select this option place your cursor anywhere on the row of the task you
wish to move, then select this option.    You will use the Goto Calendar to 
place the task on the day you wish to move the task to by double clicking 
or highlighting the day then pressing OK.    The task will be removed from 
your Master Task List and placed on your Prioritized Daily Task List on the 
date you specified.

A quicker way to perform the above actions is to click on the number to the left of the
Master Task List item you wish to affect.    A dialog box will pop-up asking you which 
action to perform on the task.



Goto
Since you can change your Master Task List categories in preferences the menu 
options here may differ from those you see but the concepts are the same.    You may 
access the Master Task List category of your choice by bringing up the Goto menu 
then selecting the category you wish to see.

-1 Category This will move you back 1 category on the Master Task List.

+1 Category This will move you forward 1 category on the Master Task List.

Category #1 This will take you directly to the Work, or whatever you may 
have designated, category's Master Task List.

Category #2 This will take you directly to the Home, or whatever you may 
have designated, category's Master Task List.

Category #3 This will take you directly to the Church, or whatever you may 
have designated, category's Master Task List.

Category #4 This will take you directly to the Misc A, or whatever you may 
have designated, category's Master Task List.

Category #5 This will take you directly to the Misc B, or whatever you may 
have designated, category's Master Task List.



Focus
If you use a computer during the day, the Focus feature allows you to view and 
concentrate only on the highest prioritized task that has not yet been completed from
your Prioritized Daily Task List.    

Focus does this by "blocking out" everything on your computer's monitor except a 
"worksheet" containing all of the information regarding the current task you are 
working on, thus making it easier to really focus on the most important task at hand.  
You may change any of the information on this work sheet and Ascend will 
automatically update your Task List with the new information.

You can also view your progress for the day graphically by selecting the following 
menu options.    First select Options, then Map.    You will now see the task map 
displayed.



Focus Menu
The following options appear on the Focus Menu:

File
Printer Setup
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear
Insert Name

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences
Task Completed
Map

Goto
Next Task
Previous Task

Help
Index
Topic
About
Registration



Focus Options
Task CompletedBy selecting this menu option, the task you are working on is 

marked as completed.    Then the Task Map, showing the number 
of tasks under each priority and the number currently completed, 
will be displayed.    After you press OK  the Focus window will bring 
up the next uncompleted task.

Map This menu option brings up a quick chart with a box for each task 
entered that day.    The boxes appear in four rows, one for each 
priority.    The completed tasks will be depicted by checkmarks in 
the corresponding boxes.    This allows you to track your progress 
through the day.



Focus Goto Menu
Next Task This option allows you to move forward or "peek" at the next 

uncompleted task.    This is useful if you must move on to the 
next task for some reason.

Previous Task This option allows you to go backwards to view the previous, 
uncompleted task.



Weekly View
Weekly view can be displayed or printed to quickly and graphically show you a 
summary of the week displaying the following information for each day:

* Appointments
* Number of Tasks
* Any special day items
In addition to the summary information for all seven days, Weekly View displays 
detailed information about one of the seven days along the bottom of the Weekly 
View window.    The day for which this detail is being displayed is designated by its 
name box being highlighted.    

To view more detail on another day simply select that day by clicking on its name box
or using the Tool Bar.    (Keyboard users may use the Goto menu option to change 
the detailed day.)



Weekly View Menu
The Weekly View menu includes the following options:

File
Printer Setup
Print
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences

Goto
Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday
-1 Week
+1 Week
Today
Date

Help
Index
Topic
About
Registration



Weekly View Goto Menu
The Goto menu in the Weekly View menu provides the following options:

Sunday This changes the page date to Sunday of the week being viewed in 
Weekly View.

Monday This changes the page date to Monday of the week being viewed in 
Weekly View.

Tuesday This changes the page date to Tuesday of the week being viewed in 
Weekly View.

Wednesday This changes the page date to Wednesday of the week being viewed in
Weekly View.

Thursday This changes the page date to Thursday of the week being viewed in 
Weekly View.

Friday This changes the page date to Friday of the week being viewed in 
Weekly View.

Saturday This changes the page date to Saturday of the week being viewed in 
Weekly View.

-1 Week This changes the page date back one week from the date being viewed
in Weekly View.

+1 Week This changes the page date forward one week from the date being 
viewed in Weekly View.

Today This changes the page date to the current system date for viewing in 
Weekly View.

Date This accesses the Goto calendar allowing you to jump to any date.



Print
Print This allows you to print your weekly view on the Franklin Weekly 

Schedule form, or on blank paper, so you can have a list of your 
appointments, and other information regarding the week with you.



Turbo File
Turbo File is a new concept introduced by Ascend that allows you to quickly find 
"things".    A "thing" could be a magazine article you once read and found interesting, 
a statement you heard and wanted to remember, a report your boss gave you, a 
piece of mail you might someday want to find, etc.    Simply think of Ascend's Turbo 
File as a very sophisticated in/out box where you can locate items in seconds.

If you have ever thought: "I wish I could remember where I read that..." or "If only I 
had saved that letter..." or "I wish I would have kept that information, I knew I would 
need it someday...." Turbo File can help.

Turbo File is basically a dialog box that allows you to fill in information, save it, then 
retrieve it at a later date.    The fields for the dialog box are explained below:

Description Enter the description of the item you are filing.    You may search by 
this description at a later date so use a unique description if possible.    
For example, if you read an article about stocks, your description might
be "Stocks for the 90's."

Key Words Enter up to five Key Words you might want to use when trying to find 
this item in the future.    For example, if you were filing an article about 
stocks, some of your key words might be Stocks, Wall Street, etc.

Location Enter the location where you will be able to find this article in the 
future.    You may enter a magazine issue, a location in your office, a 
filing cabinet number, a folder number, etc.

Category You may either select from an existing category by clicking your mouse
on the down arrow next to the Category box, or you may enter a new 
category by typing it in the box.

Type The Type field is similar to the Category field in that you may either 
select an existing Type or enter a new one.

Date Entered This field will default to Today's Date and you may leave it 
alone, or you may enter a date of when you entered this file.

Notes You may enter a more detailed description of the filed item, or type 
anything about the item you want to remember in this section.

Save After you have entered all the necessary information, select the Save 
button and    Ascend will save the record and clear the screen for a new
entry.

Find To find records you have entered into Turbo File, select the Find push 
button.    You may then perform a search to find one of your filed items.

New If you want to start on a new item without saving the current item you 
are working on, you may press the New push button.

Delete If you want to delete the current Turbo File item that is displayed, press
this button.

Prev If you want to view the previous item in the Turbo File, press this 



button.

Next If you want to view the next item in the Turbo File, press this button.



Turbo File Menu
File

Printer Setup
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences
Turbo File Categories
Turbo File Types

Help
Index
Topic
About
Registration



Finding Turbo File and Quote Records
To find an existing Turbo File or Quote record, you have several options:

1. You may type in the first few letters of the Description then select the 
Search push button.

2. You may type in one or more of the Key Words then select the Search push 
button.

3. You may do a combination of the above two items.

If you want Ascend to display all your records, simply select the Search button 
without entering anything in the Description or Key Words boxes.

When searching for a record based on Key Words, you may have Ascend retrieve 
the entry if any of the Key Words specified are found in the record or retrieve it only 
if all the Key Words specified are found in the record.

When you have found the record you were looking for and you want to view it, and/or
edit it, you may either highlight the item and select OK or double click on the item.



Journal
Ascend's Journal is very similar to the Daily Record of Events, but is kept separate so 
you may print just your Journal entries if you wish.    You may also choose to print, or 
exclude, your journal when you print your Daily Record of Events page.

Special "red letter" days may be marked as Index Entries to facilitate finding them 
later.    Entries may also be found using Ascend's global search.



Journal Menu
The Journal menu includes the following menu options:

File
Printer Setup
Print
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear
Insert Name

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences

Goto
Yesterday
Today
Tomorrow
1 Day -
1 Day +
7 Days -
7 Days +
Date

View
Index Entries
Add Index Entry

Help
Index
Topic
About
Registration





Printing Journal Entries
You have several options when it comes to printing your    journal.

Journal Index Check this box if you desire to print just a journal index.    
This will print an alphabetized "Table of Contents" to the 
indexed    entries, along with the dates where the entries 
are located.

Journal Check this box if you desire to print your actual journal 
entries for the dates specified.

Starting Date Enter the starting date of entries to be printed in the 
journal.

Ending Date Enter the ending date of entries to be printed in the 
journal.

Print only 1 Date per Page Check this box if you desire each day's entry to 
begin printing on a new page.

Pause Between Pages Check this box if you would like Ascend to pause before 
printing the next page.    This allows you time to prepare 
the next sheet of paper in the printer before printing.

Print Out Size Select the printout size you desire.

Printer Setup Accesses the printer setup so you may verify or alter the 
print settings.

When you are ready to begin printing, press the OK button.



Journal View
This menu option deals with journal index entries.    You will see the following 
selections in the drop down menu:

Index Entries This menu option will create a moveable, sizeable, "child" 
window, within the Journal window area, showing the journal 
index entries for the page date you are on.    Index entries are 
key words that mark special entries in your journal.    These 
indexed entries make it easier to find important entries on 
particular dates, such as: "Bill left for college today", or "Preston
was born."    

Close the Index Entries window by using its control menu or 
by toggling it off by selecting View then Index Entries once 
again.

Add Index Entry Brings up a dialog box so you may add a Journal Index entry.    
Index entries are used to mark days with special journal entries. 
This index may be printed separately and used as a "table of 
contents" for your journal.

Selecting Add Index Entry, will cause a dialog box to appear.    This dialog box is 
used to index entries and has the following options:

Index Entry Enter the index entry you want specified for the event.

Special Entry Check this box if you want this index entry printed in BOLD text
when you print the index.

Current Index Entries This box displays the currently defined index entries for 
that page date.

Press OK to save the new index entry or press Cancel to abort.



Favorite Quotes
The Favorite Quotes feature of Ascend allows you to store and retrieve your favorite 
quotes.    (Ascend comes with a few sample quotes.)    If you prefer to display a quote 
each time you start Ascend see More Options in the Preferences menu.    

The quotes module provides a search feature so you may quickly find all quotes 
relating to a particular topic by entering one or more "key words."    You may then 
select the particular quote you like.

The format for entering and finding quotes is very similar to that used in the Turbo 
File.



Favorite Quotes Menu
The Favorite Quotes menu includes the following selections:

File
Printer Setup
Global Search
Speed Dial
Exit

Edit
Undo
Cut
Copy
Paste
Clear

Window
Save Window Setup
Window Color
Arrange Icons
Prioritized Daily Task List
Appointment Schedule
Daily Record of Events
Address & Phone
Values & Goals
Red Tabs
Master Task List
Focus
Weekly View
Turbo File
Journal
Favorite Quotes

Options
Preferences
Quote Categories

Help
Index
Topic
About
Registration



Edit Categories
This option is used to change the name of an existing category in one of the following
areas of Ascend.

* Task Categories
* Phone Categories
* Turbo File Categories
* Turbo File Types
* Quote Categories

For example, if you had a Task Category of Phone and you wanted to change it to 
Telephone, you would select the Options menu in that module then select the 
appropriate Categories menu selection.    (Example:    In Tasks you would select Task
Categories.)

To change the Phone category to Telephone you would highlight phone in the list of
categories by clicking on it one time with your mouse or by moving to it with the 
cursor keys on the keyboard.    the word Phone would now appear in the Edit 
Category box.    Now click on the Edit Category box or press the [TAB] key to move
to it.    Type Telephone in the Edit Category box and press the [ENTER] key or OK 
to accept the change.    If you have more than one change press the [TAB] key rather 
than OK or [ENTER] to remain in the Edit Categories dialog box.    Select the OK 
button when you are finished making changes.



Ascend Tools & Utilities Program
The Ascend Tools & Utilities program is a module that runs outside of Ascend.    If fact,
it is run from Windows and will not run unless Ascend is closed.    The Tools and 
Utilities program is important because it allows you to:

* Make back-up copies of your Ascend data files.
* Restore back-up copies to your hard drive.
* Transport your data between two or more machines.
* Purge old data from your Ascend files
* Reindex your Ascend files
* Experiment with Ascend's features using Demo Data

The following selections are available under the Tools and Utilities File menu:

Backup This menu option allows you to back up the Ascend data files from your
Ascend sub-directory to a floppy diskette or another hard drive.    If 
your data will not fit on one floppy diskette, Ascend will ask for 
additional diskettes.    

Ascend will erase all data on any floppy diskette used for 
backing up, but it will not format the diskette.    Diskettes used 
for backing up must already be formatted.    (If you backup to a 
hard drive, the files in the root directory will not be erased, but the 
BACKUP file will be placed in the directory on the drive to which you 
backup.)

Restore This option allows you to restore the data from the BACKUP file to your 
Ascend sub-directory on your hard drive.    This is useful for transferring
data between machines.    You simply run the Backup routine when 
you leave one machine and do a Restore when you arrive at the other 
machine.    

Important!    Perform the restore prior to doing any work in 
Ascend since any existing data files in the Ascend sub 
directory will be overwritten by the files in the BACKUP file.

Purge This option allows you to remove old data from your Ascend data files.  
This keeps the program more manageable and provides you with a 
history of past tasks, appointments, notes, and journal entries in ASCII 
format, if you choose the archive option when purging.

Fix Header This option will reconstruct critical data that may have been corrupted 
in the data files.    Do not run this routine unless instructed to do 
so by an Ascend Support Technician.

Reindex File This option is used to "clean up" any potential problems your data files 
may have due to power failures, poor backups, etc.    If you receive a 
message stating "An Error has Occurred", Ascend will list the file in 
which the error occurred.    Reindexing that file will fix most problems 
you might encounter in Ascend.    If the problem persists or you need 
additional help, please contact Ascend's Technical Support department.





Ascend Tools & Utilities Menu
The Ascend Tools & Utilities menu includes the following options:

File
Backup
Restore
Purge
Fix Header
Reindex
Exit

Demo
Turn Demo Data On
Reset Demo Data
Remove Demo Data

Help
Index
Topic
About



Purge
Purge allows you to manage your files that contain date sensitive data.    You can 
purge and archive your "outdated" tasks, appointments, daily record of events, and 
journal entries to keep your data files smaller and more manageable.

Maintaining smaller files, by purging periodically, will speed up backups and restores, 
as well as normal day-to-day operation.

The options found in the Purge dialog box are described below:

Starting Date All data in the selected files after this date, and prior to the Ending 
Date, will be purged (and archived if you wish.)

Ending Date All data in the selected files since the Starting Date, and prior to 
this date, will be purged (and archived if you wish.)

Task List Selecting this option removes all tasks and their associated notes 
between the Starting Date and the Ending Date from your data 
files.

Appointments Selecting this option removes all appointments and their associated 
notes between the Starting Date and the Ending Date from your 
data files.

Daily Record of Events Selecting this option removes all daily record of events 
between the Starting Date and the Ending Date from your data 
files.

Journal If this option is selected all journal entries between the Starting 
Date and the Ending Date will be removed from your data files.

Pack Files Selecting this option will compress the data files after the old data 
has been removed.    If this option is not selected Purge will remove 
your old data, but the data files will remain the same size until the 
vacated spaces have been refilled with new data.

Purge Only This option removes the specified data from your data files.    The 
indicated data will be lost once this operation is performed.

Purge & Archive This option removes the specified data from your data files and 
creates an ASCII text file into which the "purged" data will be placed.
This allows you to keep your program manageable while still 
maintaining a record of tasks, appointments, etc. for future 
reference.

Output File If you select Purge & Archive you must supply a name for the ASCII 
text file that will be created.    

At the bottom of the dialog box you will see a graphical representation of how the 
purge is progressing on each of the selected files.





Demo Data
The demo data allows you to familiarize yourself with the features of Ascend without 
jeopardizing the integrity of your own data.

The Demo menu option contains the following sub-menu options:

Turn Demo Data On This temporarily stores your personal files and replaces 
them with demo data so you can learn how Ascend functions by
actually using Ascend's features.    When you're through with the
demo data and want to return to your actual data simply select 
Remove Demo Data.

Reset Demo Data This allows you to install, or reset, the demo data to help you 
familiarize yourself with the features of Ascend by actually 
using them.    Each time you reset the demo data it will load the 
demo data with today's date as a reference point so you can 
reuse the demo data to experiment as many times as you wish.

Remove Demo Data This will replace the demo data in Ascend with your 
actual data.



Ascend
A computer software program designed specifically to be used with the Franklin Day Planner.



 Backup
A routine that allows you to back up your Ascend data files from your Ascend sub-directory 
to a floppy diskette or another hard drive.



Click
Quickly press and release a mouse button, usually the left one.



Delimiter
The character used to separate different fields in a record.



DOS
Disk Operating System



Double Click
Quickly click the left mouse button twice.



Drag
Press the left mouse button and hold it down while moving the mouse.    This will allow you to
move items, make selections from pulldown menus, etc.



Field
An individual piece of information in a record.    For example the Last Name, the First Name, 
and the Company Name would be three of the fields in a single Address and Phone record.



Focus
A feature that allows you to view and concentrate on the highest-priority, uncompleted task 
from your prioritized Daily Task List.



Franklin Day Planner
A date-book-organizer to aid you in controlling daily events and schedules.    The Franklin 
Day Planner is designed to improve your personal productivity as well as help those around 
you.    For additional information about the Franklin Day Planner call 1-800-654-1775.



Goto Calendar
The Goto Calendar has several uses.    The primary purpose is to forward or move Tasks to 
other dates in the future or to the Master Task List.    The Goto Calendar can also be used to 
view Special Days, Daily Tasks, and Appointment Schedules.



Icons
Small pictures representing one of Ascend's modules or other Windows programs.



Importing Records
A routine used to put address and phone information into Ascend from another computer 
file.



Master Task List
A file to temporarily store tasks that you would like to do someday but don't want to 
schedule on a particular day yet.



Modem
A device that connects your computer with a phone line.    If you have a modem you will be 
able to use the auto dialer.



Page Date
The date that represents the date of a page in your Franklin Planner.    This is the date 
displayed between the arrows on Ascend's Tool Bar.    It may differ from today's date which is
displayed in the status ribbon at the bottom of the screen.



Point
Move the mouse until the pointer rests on the item you want.



Prioritize
A process of placing your Daily Tasks in the sequence in which you want to complete them.    
Tasks are given priorities (A, B, C, or D) based on the need you feel to complete them today.  
A tasks are vital and must be completed today, B tasks are important and should be 
completed today, C tasks have some value and could be completed today, and D tasks are
things you would like to complete at home or on your own time.



Rank
Part of the process of prioritizing your Daily Task List.    After your tasks are given an A, B, C, 
or D    priority, they are then given a numerical ranking.    (A1, A2, A3,....)



Record
A phone and address record contains all the information pertaining to a single person.    Each
record occupies a single line and consists of fields separated by a delimiter.    (Field 1, Field 2,
Field 3, Field 4, ....)



Recurring Appointments
An appointment you schedule at regular intervals.    (Every third Thursday, the 15th of every 
month, etc.)



Recurring Task
A task you wish to schedule at regular intervals.    (Every third Thursday, the 15th of every 
month, etc.)



Registration
Each Ascend program must be registered to the person or company who purchased the 
program.    Fill out your Ascend registration card and mail it to NewQuest Technologies.    
NewQuest Technologies will send a KEY NUMBER with each purchased program.    Your 
Ascend program will only work for 60 days without a Key Number.



Repeat Task
A task you want to re-schedule a certain number of days after completing the same task.    
Repeat Task are different from Recurring Task because they are re-scheduled based on the 
completion date.    (Get a haircut would probably be entered as a repeat task.)



Restore
A routine that allows you to restore data from a BACKUP you have made, usually on floppy 
diskette, to your Ascend sub-directory on your hard drive.



Search
Ascend's Global Search routine can be accessed from all Ascend modules and is used to 
search through various parts of your planner's data for a specific word or words.



Speed Dial
A method to quickly dial a phone number from your address and phone module.    You must 
have a modem to Speed Dial.



Statistics
A routine accessed from the Daily Task List.      Move the cursor to one of your tasks, pull 
down the View Menu and select Statistics.    This will display a dialog box containing misc. 
statistics about the task.



Systems Date
This is the date your computer keeps as the "currrent" date.    This is the date displayed in 
the Status Ribbon at the bottom of Ascend's window.



Task Code
A Task Code designates what action was taken on a task (completed, forwarded, delegated, 
etc.).    The Task Code column is the furthest to the left on the Prioritized Daily Task List and 
is designated by a down arrow. 



Technical Support
Refer to the on-line help and the User's Guide to answer your questions or problems.    If you 
are unable to resolve your problem, you can call Ascend's Technical Support Help Line.

Ascend's Technical Support:    801-975-9999
If your question concerns Windows, you should call Microsoft's help line.

Microsoft's Technical Support:    206-454-2030



Time Blocks
A Time Block is a 15 minute block of time.    (1 time block = 15 minutes.)    Time blocks are 
used in the Time Management routine as well as in the appointment schedule routine.



Window
A "window" is an area on your computer's screen where a program (or part of a program) is 
running.    For example, you could have one window running your Ascend, another window 
running your word processor, and still another window running your spreadsheet.    Windows 
allows you to quickly "jump" between these applications.



Font
A font is the typeface that the text is displayed or printed in.



Daily Record of Events
The right side of your planner usually used for notes, ideas and journal entries.




